
APPENDIX III.
CREATING FIGURES USING KALEIDAGRAPH

Bar charts

1.  Double-click on the KaleidaGraph 3.6 icon to open the program.  An empty data window
will appear.   Double-click on the first column heading to set the column format:  the Column
Format window will appear.  Enter the label that you wish to appear on the abscissa in place of
"A", and choose "Text" for Data Type to show the names of the categories in your data along the
axis (figure 1).

Figure 1.  Formatting the first column in a KaleidaGraph data table.

Highlight Column B and enter the label for the ordinate.  You may accept "Float" for the
Data Type and "General" for the Format.  You should consider the number of digits that would be
appropriate for your data.  If you do not wish to show trailing zeros, then click on this box to clear
it (figure 2).

Figure 2.  Continue to set the format for all data columns needed for the data to be plotted.

Click on OK to return to the data window.
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2.  Enter your data (figure 3).

Figure 3.  Type data into the highlighted cell of the KaleidaGraph data table.

When all of the data have been entered, they can be saved to your disk by pulling down the
File menu and selecting "Save Data As".  Name the file so that you will be able to identify the
dataset later, without having to open the file.  Click on the SAVE button.

3.  To create a plot of your data, pull down the Gallery menu.  Highlight "Bar", and four plot
styles will appear to the right of the menu.  Choose "Column" to show the values for each category
of measurements as vertical bars.

A box will appear (figure 4):

Figure 4.  Choosing the data columns to plot.
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Click the circle in the X column opposite the name of the data column which is to be the
abscissa, and the circles in the Y column opposite your ordinate data.  Click on the New Plot button
to see your graph.

4.  The abscissa of the new plot may not be large enough to display the category names clearly
(figure 5).

Figure 5.  The bar chart as it appears by default.

Expand the graph by clicking on the box in the upper right corner, then pull the black
border to fill the screen.

5.  Kaleidagraph will automatically supply a title that will match the title given to your data file,
and a legend above the graph. If only one set of data is presented on the graph, then the legend is
unnecessary.  If it is necessary, the legend may remain above the bars on your figure, or you may
include this information in the figure caption.  You can remove the legend by going to the Plot
menu and selecting "Display Legend".

The title should also be removed.   In the Plot menu, select "Display Title".

You should write the figure caption using word processing software, and paste the finished
figure above the caption.  Figure captions must include all the information necessary to understand
the graph (see Jan A. Pechenik, A Short Guide to Writing About Biology).

6.  If you need to revise an axis label, double-click on the label.  A window will open (figure 6).
You may also change the font, size, or style of the label from this window.  When done, click on the
OK button.
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Figure 6.  The window from which you can change the content or style of axis labels.

7.  To add or remove grid lines, pull down the Plot menu and select "Axis Options".  The Axis
Settings window will appear (figure 7).  Click the circle labeled "Grids".  Click on the boxes for
major and minor grid lines to choose the grid you prefer for the x-axis.  Click on the "X" in the
upper left corner and select "Y" to choose the grid lines for the y-axis.  Click on the OK button.

The limits of the axes may also be changed from this window.  Click on the circle labeled
"Limits" and type in the maximum and minimum you would like.  Unless there are negative values
in your data, axes should start at zero.

Figure 7.  The Axis Settings window, from which you may remove grid lines and extra axes from your figure.

8.  If your bar chart depicts two nested sets of categories (e.g., measurements from two field
plots for several tree species), change the spacing to pair the columns for each field plot within tree
species:  pull down the Format menu and select "Plot Extras".

At the right of the window you will see the "Column Plot Options".  Change the "Column
Offset"  to the desired proportion of the column width.  In the example below (figure 8), the
spacing between the pairs of columns for each tree species will be 30% of the width of each
column.

Click OK when finished.



KaleidaGraph Appendix III - 5

Figure 8.  Changing the column offset to nest columns within categories.

9.  Select the column fill pattern and color by pulling down the Plot menu and selecting Plot
Style (figure 9).

Figure 9.  Select contrasting fill patterns in black and white to clearly show different categories of data.

Select the "Fill Pattern" for the columns showing the values from your first category by
clicking on the desired pattern.  Then select the color for those columns.

Remember that a good figure should be clear and easily interpreted. Figures for Biology 2
should be in black and white.  Contrast the values from your two field plots using pattern.  In
general, unless color is part of the data that you are presenting, figures in formal papers in Biology
are not in color.
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Click on "Plot Variable: >>" at the top of the window to select the style for the columns
showing the values from your second category.

Click on OK when finished.

10.  The finished figure should be easily understood on its own merits.  Double-check your
figure caption to be sure that you have included all information that a reader would need to
understand the data presented.  Because figures are so important to the clear and complete
presentation of data, your figures should be created early in the writing process, and polished
figures should be reviewed with the first draft of writing assignments.

What refinements would you make to figure 10?  What information do you need in the
figure caption to understand this figure?

0

10

20

30

40

50

60

Q. rubra F. grandifolia A. rubrum A. platanoides A. negundo N. sylvatica S. albidum L. tulipiferaF. pennsylvanica

Species

Figure 10.  Review the finished figure critically for correctness and clarity of information.

Line graphs

1.  Double-click on the KaleidaGraph 3.6 icon to open the program.  An empty data window
will appear.   Double-click on the first column heading to set the column format:  the Column
Format window will appear.  Enter the label that you wish to appear on the abscissa in place of
"A", and choose "Integer" for Data Type if these data are integers, or "Float" if the data are
decimals (figure 11).

Highlight Column B and enter the label for the ordinate.  You may accept "Float" for the
Data Type and "General" for the Format.  You should consider the number of digits that would be
appropriate for your data.  If you do not wish to show trailing zeros, then click on this box to clear
it.  Click on "Done" to return to the data window.
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Figure 11.  Setting the format of the data columns.

2.  Enter your data (figure 12).

Figure 12. Type data into the highlighted cell of the KaleidaGraph data table.

When all of the data have been entered, they can be saved to your disk by pulling down the
File menu and selecting "Save Data As".  Name the file so that you will be able to identify the
experiment later, without having to open the file.  Click on the SAVE button.

3.  To create a plot of your data, pull down the Gallery menu.  Highlight "Linear", and four
plot styles will appear to the right of the menu.  Move the mouse to select "Line" if you want the
data points connected, or "Scatter" if you wish to plot the points without a connecting line.

A box will appear (figure 13).
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Figure 13.  Choose data columns to be the ordinate and abscissa.

Click the circle in the X column opposite the name of the data column which is to be the
abscissa, and the circle in the Y column opposite your ordinate.  Click on the NEW PLOT button to
see your graph.

4.  Expand the graph by clicking on the box in the upper right corner, then pull the black border
to fill the screen.

5.  Kaleidagraph will automatically supply a title that will match the title given to your data file,
and a legend above the graph.  If only one set of data is presented on the graph, then the legend is
unnecessary.  You can remove it by going to the Plot menu and selecting "Display Legend".

The title should also be removed.   In the Plot menu, select "Display Title".

You should write the figure caption using word processing software, and paste the finished
figure above the caption.  Figure captions must include all the information necessary to understand
the graph (see Jan A. Pechenik, A Short Guide to Writing About Biology).

6.  If you need to revise an axis label, double-click on the label.  A window will open, in which
you can type the new label.  You may also change the font, size, or style of the label from this
window.  When done, click on the OK button.

7.  To add or remove grid lines, pull down the Plot menu and select "Axis Options".  The Axis
Settings window will appear (figure 14).  Click the circle labeled "Grids".  Click on the boxes for
major and minor grid lines to choose the grid you prefer for the x-axis.  Click on the "X" in the
upper left corner and select "Y" to choose the grid lines for the y-axis.  Click on the OK button.

Figure 14.  The Axis Settings window.
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The limits of the axes may also be changed from this window.  Click on the circle labeled
"Limits" and type in the maximum and minimum you would like.  Unless there are negative values
in your data, axes should start at zero.

8.  The finished graph may be saved to your disk.  Pull down the File menu and select "Save
Graph As".  Once again, choose a file name which clearly identifies the experiment and the figure.
This name will not appear when you print the graph.

To fit a line to data using Kaleidagraph:

1.  Occasionally you may prefer to calculate the line of best fit to your data, and show this line
along with the actual data points.  To create this type of graph, enter the data as before.  Pull down
the Gallery menu, highlight "Linear", and select "Scatter".  Choose the x- and y-axes in the plot
box, as before, and click on the NEW PLOT button to see your graph.

2.  Pull down the Curve Fit menu and select "Linear".   Check the box for the ordinate data in
the window that appears.  Click on the OK button to continue.   The plot should now have the best
line drawn between the points.  The equation of the line should appear above the graph.  This
information should be put into the figure caption.  To remove the equation from above the graph,
pull down the Plot menu and select "Display Equation".

Other useful tricks

1.  By clicking on the box inside the gray bar at the top left of the plot window, a number of
tools will appear (figure15).  The Text tool (T) can be used to add labels on your graph, to identify
specific points or different sets of data.  Highlight the box containing this symbol to use the tool.
Position the cursor in the space where you would like the label to appear.  Double-click, and a
window will appear in which you can type.  Select the font, size, and style.  When finished, click on
the OK button.

Figure 15.  Add text or modify other components of your figure using the Tool window at the top left.
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2.  The Line/Arrow tool (\) will add an arrow to call attention to data points or trends.  Highlight
the box containing this symbol to use the tool.  Position the cursor at the point where you would
like the head of the arrow, click and drag to form a line.  Release the mouse.

To create error bars around means:

1.  If the points on your graph represent mean values, you may wish to include error bars to
show the amount of variation in your data around the mean.  Standard deviation is a common
measure of variation (see Appendix I for a discussion of means and standard deviations).  Calculate
the means and the standard deviation of each mean using the formulas given in Appendix I, or click
once on the column(s) of data in your data window that you need to summarize.  The column
should turn black, indicating that it is selected.  Pull down the Functions menu, and choose
"Statistics…".  A window will open that lists several statistics for your data (Figure 16).  Record
the mean, standard deviation and count in your notebook.

Figure 16.  Calculating basic statistics using KaleidaGraph.

2.  Create three new columns for your independent variable, the mean values of the dependent
variable, and the standard deviation of each mean:  pull down the Data menu and choose "Append
Column" three times.  Define the columns as before (Figure 17).  Consider the number of digits
appropriate for your measurements.

Figure 17.  Defining your new columns.
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3.  Enter the calculated values into your data window.

4.  Plot the mean against the independent variable (Figure 18).

Figure 18.  Choosing the independent and dependent variables.

5.  From the Plot menu, choose "Error Bars…".  In the small window that opens, click on "Y
Err" to show variation around the mean of your measured variable.  Another window will open to
allow you to specify the value the error bars will represent.  Click on the small inverted triangle in
the right corner of the center rectangle (Figure 19).

Figure 19.  Setting the value of the error bars.
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6.  DO NOT choose "Standard Deviation" from the menu that opens!  KaleidaGraph
will not calculate the standard deviations from the appropriate data columns with this command!
Choose "Data Column", then choose the column in which you entered the correct values for
standard deviations around the means.  Click "OK".  Then click on "Plot"  to see your new graph
with error bars.

7.  Make sure that the Y-axis is long enough to encompass the entire height of the error bars
(Figure 20).

Figure 20.  Completed graph showing means and standard deviations using error bars.

8.  Remember that since error bars can show a number of different values, you should include a
statement that the error bars indicate standard deviations, and that the points shown are means (of
how many measurements?) in your figure caption.

Saving your work:

The finished graph may be saved to your disk.  Pull down the File menu and select "Save
Graph As".  Once again, choose a file name which clearly identifies the experiment and the figure.
This name will not appear when you print the graph.

KaleidaGraph saves the Data file and the Graph file separately.  Back up the figure and the
data together.  If you have not saved the data to the same disk as the graph, you will not be able to
open the graph later.


